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Introduction 
Illustrator is a vector graphic editing program by Adobe.  This booklet is designed to introduce you to 

the essential skills you need to get started using some of the basic Illustrator tools.  These instructions 

were created using Illustrator CS5.1 for Windows; the Mac OS X version is similar. 

About Vector Graphics 
Vector graphics are made up of lines and curves called vectors. They are resolution-independent, 

meaning they can be scaled to any size and printed at any resolution without losing detail. You can 

move, resize, or change the color of vector objects without losing the quality in the graphic. 

Opening Illustrator 
Follow these instructions to access the Illustrator program. 

1. Click the Windows Start button.

2. Click All Programs.

3. Scroll down and click the Adobe Master Collection CS5.5 folder.

4. Click Adobe Illustrator CS5.1.
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Opening a New Document 
Follow these instructions to open a new file. 

1. Click the File menu and select New. The New Dialog window will appear (See Figure 1).

2. Choose a name for the Document.

Note: You can either name the document now or later when you are saving.

3. Choose one of the preset Document profiles from the New Document Profile drop down.

4. Enter the number of artboards (pages) that you would like to have in the document.

Note: If you enter 2 or more artboards, choose how you would like them arranged, using the

buttons to the right of “Number of Artboards”.  Choose how much spacing you would like

between each artboard, and the number of columns you would like.

5. Select the paper size.

6. Select the units of measurement that you prefer.

7. Select the orientation type. (Portrait or Landscape)

8. Select OK once you are done making selections.

Figure 1: New Document Dialog Window 
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Exploring the Interface 

Figure 2: Adobe Illustrator Interface 

1. Menu Bar – File, Edit, etc. Illustrator functions are available from the drop-down menus.

2. Control Bar – Displays options relevant to the selected tool.

3. Artboard – Allows you to create and edit objects/graphics in this area, to be printed.

4. Scratch Area – Objects/graphics can be created in the scratch area, but will not be printed.

5. Tools Panel – Tools used to create objects/graphics.

6. Document Name – The name of the document.

7. Panels – Panels hold multiple options used for editing and manipulating objects.  To display

more panels, go to Window on the menu bar.

8. Window Zoom – Allows you to control the zoom of the window.

9. Current Tool – Displays the current selected tool.
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Illustrator Tools and Shortcuts 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tools panel overview, credit: Adobe, see 
http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0100196cbc5f-6337a.html 

 

*Note: Most tools show a triangle in the lower right corner, meaning that there are other tools hidden 

below the tool.    To view the hidden tools panel, hold down the mouse button on the visible tool.  

To tear off hidden tools in a separate panel, drag the pointer over the arrow at the end of the hidden 

tools panel and release the mouse button. 

 

   

Figure 3: Tools Panel Overview 

http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0100196cbc5f-6337a.html


Page 9 of 42 

 

 

Keyboard Shortcuts for Drawing 

Figure 4: Shortcuts for Drawing 

 

  

Shift + Drag Constrain a shape’s proportions or orientation  

Spacebar + Drag Move a shape while drawing it 

Alt + Drag Draw from the center of a shape (except for polygons, stars, and flares) 

Drag, then press Up or Down 

arrow key 

Increase or decrease polygon sides, star points, arc angle, spiral winds, 

or flare rays 

Drag, then hold down Ctrl key Keep the inner radius of a star constant/increase length of star points 

Drag, then hold down F key Flip an arc, keeping the reference point constant 

Drag, then Ctrl drag Change the decay rate of a spiral 

Drag, then Alt drag Add or subtract winds from a spiral while increasing the length of the  

spiral 

Drag, then press up or down 

arrow key 

Add or remove horizontal lines from a rectangular grid  or concentric 

lines from a polar grid 

Drag, then press left or right  

arrow key 

Add or remove vertical lines from a rectangular grid or radial lines from 

a polar grid 
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Using Color in Illustrator 
The swatches panel allows you to access basic color, gradient, and pattern choices (See Figure 5).  

Accessing color from the Control Bar is probably the easiest way to make color choices (See Figure 6).  

The Fill and Stroke drop-down lists allow quick access to the Swatches panel to apply color to the fill 

and/or stroke of an object. 

 

 
Figure 5: Swatches Panel 

 

 

 
Figure 6: Control Panel – Fill & Stroke 

 Drop-down buttons 

 

Applying Color to an Object: 

Follow the instructions below to apply color to an object’s Fill (inside) or Stroke (border or path). 

 

1. Select the object.  

2. From the Control Bar, click the Fill or Stoke drop-down button. 

3. Select a color. 

Alternate Options: 

Option 1 

1. Select the object. 

2. Fill and Stroke color buttons (See Figure 7) are also located at the bottom of the Tools panel. 

 
  Figure 7:  Fill & Stroke color buttons 
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*Note: If you are applying color to the Fill, the Fill button must be on top.  If you are applying 

color to the stroke, the Stroke button must be on top. To switch the position of the Fill and 

Stroke color buttons, simply click on the appropriate button, or use the shortcut key X to toggle 

from Fill to Stroke and vice versa. 

 

3. Once you have selected the appropriate button, select a color from the swatches panel to apply 

to your selection.  

 

Option 2 

1. Select an object. 

2. To apply a fill color, select a color from the Swatches panel and drag it to the object.   

3. To apply a stroke color, select a color from the Swatches panel, hold down Alt+Shift+Ctrl, and 

drag the color to the object. 

 

Pen Tools  
The Pen tools can be used to create elements, such as straight lines, curves, and closed shapes. 

 

 
Figure 8: Pen Tools 

 

Pen Tool  

The simplest path you can create with the pen tool is a straight line.  The pen tool allows you to set 

anchor points, and then Illustrator inserts the line to connect the anchor points and create paths.  

 

1. Select the Pen tool from the Tool panel.  

2. Click on the artboard where you want the line to begin, to set the first anchor point (See Figure 

9). 

 

 
Figure 9: 1st Anchor Point 
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3. Move across from the anchor point you just created, as if drawing a straight line, and click again 

to set the second anchor point and create the line segment (See Figure 10). 

 

*Note: As you move the pen tool across the artboard, you will notice a green line appear.  This 

line is called a guide (See Figure 10). The guide helps you to stay in line with the previous 

anchor point created, to ensure the connecting path will be a straight line. 

 

 

  
Figure 10: Guide and 2nd Anchor Point 

 

 

 

4. Move the pen tool up to set the top point of the triangle.  As you move up and toward the 

center of the path you previously created, you will notice a vertical guide verifying that you are 

at the center point of the path (See Figure 11). 

 

5. Click to create a third anchor point (See Figure 11). 

 

 

   
Figure 11: Vertical Guide and 3

rd
 Anchor Point 
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6. Using the pen tool, hover over the first anchor point that was created.  To the lower right of the 

pen tool, where there was an (x), there should now be a (o). The (o) means that you are about 

to close the path (See Figure 12). 

 

 
Figure 12: Using the Pen Tool to Close Path 

 

7. Click the anchor point to close the path (See Figure 13). 

 

    

 
Figure 13: Closed Path 

 

 

Add Anchor Point Tool   

To add an anchor point to the object, select an object, select the Add Anchor Point tool,  and click 

a position on the path to add an anchor point. 
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Delete Anchor Point Tool   

To remove an anchor point, select an object, select the delete anchor point tool,  and click on an 

anchor point to remove that anchor point from the object. 

 

Convert Anchor Point Tool   

To convert an anchor point and create a curved path, select the object, select the Convert Anchor Point 

tool.  Hover over the anchor that you want to convert. Click and drag to turn the straight path into 

a curved path. 

 

The Selection Tools 
 

 
Figure 14: Selection Tools 

 

Select Tool  

Use the Select Tool to select objects or groups. This tool activates all anchor points in an object or 

group at the same time, allowing you to move an object without changing its shape.  

Selecting an Object 

1. Select the Select tool.   

 

2. Simply click the object to select it, or click and drag allowing your pointer to touch the object.  

Either of these options will select the object.  Once selected, a bounding box will appear around 

the object (See Figure 15 on next page). The bounding box allows an easy and effective way to 

resize an object using its sizing handles. 

 

*Note: To remove the bounding box, select View → Hide Bounding Box. 
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Figure 15: Bounding Box 

 

Selecting Multiple Objects 

1. Select the Select tool. 

 

2. Click an object to select it. 

 

3. While pressing the Shift key on your keyboard, click the other objects that you would like to 

select. 

 

Alternate Option: 

4. Using the select tool, click and drag, touching each object that you want to select. 

 

Resizing an Object 

1. Select the Select tool. 

 

2. Hover over one of the corners or side sizing handles. Click and drag to resize the object. 

 

Moving an Object 

1. Select the Select tool. 

 

2. Hover over a path in the object. Click the path and drag to move to your desired location. 
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Duplicating an Object 

1. Select the Select tool and select the object.

2. Position the pointer over the path of the object.

3. Hold down the Alt key.

4. Click the path and drag. Once in the desired location, release the mouse first, then the Alt key.

Direct Selection Tool  

Use the Direct Selection tool to select individual or multiple anchor points to manipulate the shape of 

the object. 

Selecting an Anchor Point 

1. Select the Direct Selection tool.

2. Click one of the anchor points. The anchor point is now selected and is solid filled.  The other

anchor points will be hollow (See Figure 16).

Figure 16: Solid Filled and Hollow Anchor Points 

3. Click the filled anchor point and drag to manipulate the shape of the object (See Figure 17 on

the next page).

*Note: Hollow anchor points will not move while dragging the selected anchor point

4. Once you are done manipulating the object, release the mouse button.
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Figure 17: Manipulating the Object 

Selecting Multiple Anchor Points 

1. Select the Direct Selection tool.

2. Click on an anchor point.

3. Hold down the Shift key and click additional anchor points (See Figure 18 on the next page).

*Note: If you select all anchor points on the object, you will not be able to manipulate the

object. You will only be allowed to move it to another location. 
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Figure 18: Selecting Multiple Anchor Points  

 

 
 
 

Group Selection Tool 

Hidden within the Direct Selection tool, the Group Selection tool  is used to select items within a 

group. This tool adds grouped items as you click objects in the order in which they were grouped. This 

selection tool becomes more useful to you as you become more familiar with grouping objects in 

Illustrator.  

 

Magic Wand Tool  

Use the Magic Wand tool to select objects with like values, such as fill and stroke colors, based on a 

tolerance and stroke weight. Change the options of this tool by double-clicking on the tool. 

Selecting objects 

1. Draw three triangles. 

 

2. Change the fill color and stroke color of all the triangles, making two exactly the same and one 

different from the other two. 

 

3. Select the Magic Wand tool.   
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4. Click on one of the two triangles that are the same.  The triangles that are the same are 

selected (See Figure 19). 

 

 
Figure 19: Using the Magic Wand  

 

Lasso Tool  

Use the lasso too to draw freehand to select anchor points or objects. 

Selecting an anchor point or object 

1. Select the lasso tool.  

 

2. Click and drag to draw a circle around the first two triangles.  Upon releasing the mouse button, 

the two objects will be selected (See Figure 20 on the next page). 
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Figure 20: Using the Lasso Tool 

 

The Line Tools 
Use the line tools to draw straight or curved lines, spirals, and grids.  When creating lines, you create 

the line and Illustrator inserts the anchor points. Stroke changes the color of the line. 

Uniform changes the shape of the line. You can also change the weight of a line. 

 

  

Figure 21: Line Tools 

 

Line Segment Tool    

Use the line tool to create a line. 

 

Creating a line 

1. Select the line tool.   

 

2. Position the pointer where you want the line to begin. 

 

3. Click and drag to where you want the line to end.  Once you release the mouse, your line will be 

drawn with two anchor points at each end (See Figure 22 on the next page). 

 

*Note: To ensure a straight line, hold down the shift key while dragging the mouse. 
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Changing the line color 

1. Select the line using the select tool. 

2. Select a color from the stroke button on the control bar  (See Figure 22).    

 

Changing the thickness of the line 

1. Select the line using the select tool.   

2. Select the drop-down arrow next to the (pt) in the control bar.   

 

3. Select an option (See Figure 22). 

 

*Note: The higher the number the thicker the line. 

 

Changing the shape of the line 

1. Select the line using the select tool. 

2. Select the drop-down arrow next to Uniform on the control bar.   

 

3. Choose a new shape (See Figure 22). 

 

 
Figure 22: Creating and Editing a Line 

 



Page 22 of 42 

 

 

Arc Tool   

Use the arc tool to create curved paths (See Figure 4 for keyboard shortcuts). 

 

Creating a curved path 

1. Select the arc tool, hidden beneath the line segment tool.   

 

2. Position the pointer where you want the arc to begin. 

 

3. Click and drag to the position where you want the arc to end. Once you release the mouse, you 

will have created a curved path.  

 

*Note: To flip the arc to the opposite direction, while dragging, press the (F) key on the 

keyboard. 

 

 

Spiral Tool   

Use the spiral tool to create spiral paths (See Figure 4 for keyboard shortcuts). 

 

Creating a spiral 

1. Select the spiral tool hidden beneath the line segment tool.   

 

2. Position the pointer in the position where you want to draw the spiral. 

 

3. Click and drag to your desired size. Drag in an arc direction to rotate the spiral. 

 

Rectangular Grid Tool   

The rectangular grid tool creates rectangular grids of a specified size with a specified number of 

dividers (See Figure 4 for keyboard shortcuts). 

 

Creating a Rectangular Grid 

1. Select the Rectangular Grid tool hidden beneath the line segment tool.   

 

2. Position the pointer where you want to begin the grid. 
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3. Click and drag until you reach the desired size (See Figure 23). 

 

*Note: To add or remove horizontal lines, while dragging; press the ↑↓ arrow keys on the 
keyboard. To add or remove vertical lines, while dragging; press the ←→ arrow keys on the 
keyboard. 

 

 
Figure 23: Creating a Rectangular Grid 

 

 

Polar Grid Tool   

The polar grid tool creates concentric circles of a specified size with a specified number of dividers (See 

Figure 4 for keyboard shortcuts). 

 

Creating a Circular (Polar) Tool  

1. Select the Polar Grid Tool hidden beneath the line segment tool.   

 

2. Position the pointer where you want to begin drawing the grid. 

 

3. Click and drag until you reach the desired size (See Figure 24 on the next page). 
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*Note: To add or remove concentric circles, while dragging; press the ↑↓ arrow keys on the 
keyboard.  To add or remove line segment dividers, while dragging, press the ←→ arrow keys 
on the keyboard. 

 

 
Figure 24: Creating a Polar Grid 

 

The Pencil Tools 
The Pencil tool allows you to draw as if you were drawing with a pencil on paper.  It is most useful for 

fast sketching or creating a hand-drawn look.  Once you draw a path, you can immediately change it if 

needed.  As you draw with the pencil tool, anchor points are set on the path.  Illustrator determines 

the position they are set. 

 

 
Figure 25: Pencil Tools 

 

Pencil Tool   

Drawing a freeform path with the Pencil Tool (See Figure 26 on the next page). 

1. Select the pencil tool.   

 

2. Position the tool where you want the path to begin. 
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3. Click and drag to draw a path. The pencil tool will display a small x to indicate that you are 

drawing a freeform path.  

 

*Note: As you drag, a dotted line will follow giving you a preview of the path being drawn.  

 

4. Once you release the mouse, the dotted line will change into a solid line, and Illustrator will 

insert the anchor points. 

 

 
Figure 26: Drawing a Freeform Path 

 

 

Drawing a closed path with the Pencil Tool (See Figure 27 on the next page). 

1. Select the pencil tool. 

 

2. Position the tool where you want the path to begin. 

 

3. After you begin dragging, hold down the Alt key. The pencil tool will display a small circle to 

indicate that you are drawing a close path. 

 

4. Once the path is to your desired size and shape, release the mouse button first. Once the path 

closes, release the Alt key. 
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*Note: You do not have to position the cursor over the starting point to close the path.  If you 

release the mouse in another location, the Pencil tool will close the shape once you release the 

mouse. 

 

 
Figure 27: Drawing a closed path 

 

 

Edit Paths using the Pencil Tool 

Add to a path  

1. Select an existing path. 

 

2. Select the Pencil tool. 

 

3. Position the pencil on an endpoint of the path. 

 

*Note: You will know that you are positioned on the endpoint once the x next to the pencil tool 

disappears.  

 

4. Click and drag to continue the path in the desired direction. 

 

Reshape a closed path 

1. Select a closed path. 

 

2. Select the Pencil tool. 
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3. Position the Pencil tool on the path, in the position where you want to begin redrawing. 

*Note: You will know you are on the path when the x next to the pencil tool disappears. 

 

4. Click and drag creating the desired shape. 

*Note: In order for the path to remain closed, be sure to release the mouse while hovering over 

a different position on the path. 

 

Smooth Tool   

The Smooth tool will round out and straighten any crooked, pointy, or jagged parts of the path to make 

it look smoother. 
 

1. Select the object. 

2. Select the Smooth tool hidden beneath the pencil tool.   

 

3. Position the pointer where you would like to begin. 

 

4. Click and drag the tool across the top of the path in the area that you want to smooth out.  

 

5. Repeat this step to this portion of the path until you get the desired results (See Figure 28).  

 

 
Figure 28: Using the Smooth Tool 
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Path Eraser Tool   

The Path Eraser tool allows you to erase parts of the path. 

 

1. Select the object. 

2. Select the Path Eraser tool hidden beneath the pencil tool.   

 

3. Position the pointer at a position in the path that you would like to erase. 

 

4. Click and drag over the area that you would like to erase (See Figure 29). 

 

 
Figure 29: Using the Path Eraser tool 

 

 

Creating Basic Shapes 
(Refer to Figure 4 to view keyboard shortcuts that can be used when drawing shapes.) 

 

 
Figure 30: Basic Shapes 
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Rectangle Tool   

Create rectangles and squares using the Rectangle tool. 

1. Select the Rectangle tool.  

 

2. Click on the page where you want the shape to begin, and then drag until you reach the desired 

size. 

*Note: You can also drag to the left, right, up, or down. 

 

3. After you create the shape, you can adjust the size and position by using the Selection tool. 

 

Alternate Option: 

1. Select the Rectangle tool. 

 

2. Click where you want the top left corner of the shape to be. 

 

3. Once the dialog box opens, enter the dimensions for the shape. 

 

4. Select OK. 

 

Rounded Rectangle Tool   

1. Select the Rounded Rectangle tool hidden beneath the Rectangle tool.  

 

2. Click on the page where you want the shape to begin, and drag diagonally until you reach the 

desired size. 

*Note: You can also drag to the left, right, up, or down. 

 

3. After you create the shape, you can adjust the size and position by using the Selection tool. 

 

Alternate Option: 

1. Select the Rounded Rectangle tool. 

 

2. Click where you want the top left corner of the bounding box to be. 

 

3. Once the dialog box opens, enter the values for the shape. 

 

*Note: The Corner Radius text field determines how much rounding is applied to the corners of 

the shape. 

 

4. Select OK. 
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Ellipse Tool   

Create circles and ovals using the Ellipse tool. 

1. Select the Ellipse tool hidden beneath the Rectangle tool.  

 

2. Click on the page where you want the shape to begin, and drag diagonally until you reach the 

desired size. 

*Note: You can also drag to the left, right, up, or down. 

 

3. After you create the shape, you can adjust the size and position by using the Selection tool. 

 

Alternate Option: 

1. Select the Ellipse tool. 

 

2. Click where you want the top-left corner of the ellipse’s bounding box to be. 

 

3. Once the dialog box opens, enter the dimensions for the shape. 

 

4. Select OK. 

 

Polygon Tool   

1. Select the Polygon tool hidden beneath the Rectangle tool.   

 

2. Click on the page where you want the shape to begin, and drag diagonally until you reach the 

desired size. 

*Note: The default is a six-sided polygon. 

 

3. After you create the shape, you can adjust the size and position by using the Selection tool. 

 

Alternate Option: 

1. Select the Polygon tool. 

 

2. Click where you want the center of the polygon to be. 

 

3. Once the dialog box opens, enter the values for the shape. 

*Note: Radius is determined from the center to the edge of the polygon.  The value for the 

number of sides can range from 3 (creating a triangle) to 1000. 

 

4. Select OK. 
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Star Tool   

1. Select the Star tool hidden beneath the Rectangle tool.   

 

2. Click on the page where you want the shape to begin, and drag diagonally until you reach the 

desired size. 

*Note: The default is set to create a five-point star. 

 

Alternate Option: 

1. Select the Star tool. 

 

2. Click where you want the center of the star to be. 

 

3. Once the dialog box opens, enter the values for the shape. 

 

*Note:  For Radius 1, specify the distance from the center of the star to the star’s inner points.  

For Radius 2, specify the distance from the center of the star to the star’s outer points.  For 

Points, specify how many points you want the star to have. 

 

4. Click OK. 

 

The Eraser Tool   
The eraser tool allows you to erase mistakes or manipulate objects. 

 

Using the Eraser Tool 

1. Draw a basic shape and fill it with a color. 

2. Select the Eraser tool.   

 

3. Click and drag the Eraser across the shape from left to right. 

 

*Note: You now have two objects that you can manipulate separately (See Figure 31 on the 

next page). 
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Figure 31: Using the Eraser Tool 

 

 

Changing the Eraser Tool Options 

1. Double-click the eraser tool to bring up the options dialog box. 

 

2. Change the eraser size by changing the number in the “Diameter” box. 

 

3. Change the “Angle” and “Roundness” values to further customize the eraser. 

 

4. Preview your options in the small white square at the top of the dialog box. 

 

5. Click OK. 

 

The Shape Builder Tools 
The Shape Builder tool is used for creating complex shapes by merging and erasing simple shapes.  You 

can also edit overlapping shapes and fill those in with color using the Live Paint Bucket tool. 

 

 
Figure 32: Shape Builder Tools 
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Shape Builder Tool   

The Shape Builder tool is an interactive tool for creating complex shapes by the merging and erasing of 

simple shapes. 

 

1. Create several overlapping shapes (See Figure 33). 

 

2. Select the shapes that you want to combine. 

3. Select the Shape Builder tool.   

 

4. Click and drag across the selected shapes.  The shapes are merged into one shape. 

 

5. Create another shape that overlaps your new combined shape. 

 

6. Using the Selection tool, select both shapes. 

 

7. Select the Shape Builder tool again. 

 

8. Hold down the Alt key then click and drag across the new shape where it overlaps with the 

previous shape.  The new shape is erased from the underlying shape. 

 

 
Figure 33: Using the Shape Builder Tool 
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Live Paint Bucket Tool    

The Live Paint Bucket tool allows you to break and edit overlapping shapes and intuitively fill those in-

process shapes with color.  

 

1. Choose the Select tool and select the object created in the Shape Builder Tool exercise. 

 

2. Make sure the Fill swatch is forward on the Tools panel. 

3. Select the Live Paint Bucket tool, hidden beneath Shape Builder tool.   

 

4. Choose a fill color from the swatches or color panel. 

 

5. Click in the region you want to fill with that color (See Figure 34). 

*Note: Pressing the ←→ arrow keys will allow you to easily choose colors from the swatches 

panel. 

 

 
Figure 34: Using the Live Paint Bucket tool 
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Changing the Background Color of an Artboard 
Because Illustrator is a vector drawing program, you always have to create an object to apply color to; 

there is no “background” layer, as there is in Photoshop.  So to change the background color of an 

artboard, we will use an object.  The following instructions explain how to change the background 

color of an artboard using objects. 

 

Select the Rectangle tool.   

1. Position the crosshairs at the top-left corner of the artboard until you see the word intersect 

(See Figure 35). 

 

2. Click and drag in a diagonal direction to the bottom-right corner until you see the word 

intersect (See Figure 35). 

*Note: The idea is to draw a rectangle the exact same size as the artboard. 

 

      
Top-left corner of artboard Bottom-right corner of artboard 

Figure 35: Drawing the Rectangle 

 

 

3. From the Control Panel, choose a Fill color.    

 

4. At the bottom of the panels to the right of your window, you should see a Layers panel (See 

Figure 36). 

*Note: If you do not see the layers panel, go to the Window menu and select Layers. 

 

 
Figure 36: Layers Panel 

 

5. In the Layers Panel, notice Layer 1.  To the far left of Layer 1 you will see an open eye.    

Next to the eye, there will be an empty square.   Click the empty square.  A lock will appear, 
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locking this layer.   If you try to create art on the artboard now, you will not be able to do 

so. 

*Note: We are locking this layer to prevent it from moving as we create art on the artboard. 

 

6. Click the Add Layer icon at the bottom of the Layers panel, next to the trash can.   

 

7. You can now begin creating art on the Artboard (See Figure 37). 

 

*Note: If you plan on changing the background color of your artboard, it is recommended that 

you do this, before you begin creating art on the artboard.   Changing the background color 

after you have created art, may cause your art to be hidden from view. 

 

 
Figure 37: Changing the Artboard Background Color 

 

Text 
There are several types of text that you can add to and Illustrator file.  The following instructions will 

explain how to apply Point type text and Area type text.  The instructions will also explain how to add 

text to a path, and how to add text on a closed shape.  From the Control panel select Character to edit 

text. 
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Point Type 

1. Select the Type tool.   

 

2. Click where you want to begin typing (See Figure 38 on the next page). 

*Note: Press Enter to start a new line. 

 

Area Type 

1. Select the Type tool.   

 

2. Click and drag on the page to create a textbox.  This will be the area that your text will be 

displayed. 

 

3. Begin typing and continue until you are done.  Your text will automatically wrap to the next line 

(See Figure 38 on the next page). 

*Note: You do not need to press Enter to start a new line. 

 

Alternate Option: 

1. Double-Click the type tool to view the area type options dialog box. 

 

2. Enter the desired specifications for the textbox. 

 

3. Click OK. 

 

Adding Text to a Path 

 

1. Create a path using the pen, line, or pencil tool. 

 

2. Select the Type tool. 

 

3. Hover over the start of the path until your cursor turns into an I-bar with a squiggle, and then 

click. 

 

4. Begin typing.  Your text will run along the selected path (See Figure 38 on the next page). 

 

Adding Text on a Closed Shape 

 

1. Create a closed shape, a circle or oval for example. 

 

2. Select the Type tool. 
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3. Hover over the path of the closed shape until you see the I-bar become rounded.  Hold down 

the Alt key to change the icon to the squiggle line. 

 

4. When the squiggle line appears, click and begin typing.  The text will flow around the path of 

the shape (See Figure 38). 

 

 
Figure 38: Using the Text Tool 

 

Saving a file 
 

1. Select File on the menu bar, then select Save. The Save As dialog box appears (See Figure 39 on 

the next page). 

 

2. Choose where you want to save the file, e.g., Desktop, Computer. 

 

3. Give the file a name and file type. 

*Note: Saving a file as an (*.AI) file, will allow you to open and edit the document in Illustrator. 

 

4. Select Save. 
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Figure 39: Save Window 

 

 

 

5. Select Save again to open the Illustrator Options dialog box (See Figure 40 on the next page). 

 

6. Choose the Version you want to save the file as. 

 

*Note: Artboards were not introduced in Illustrator until version CS4.  Therefore, if you choose 

to save the file in a version earlier than CS4, you will have to save each artboard to a separate 

file. 

 

7. Choose your options. 

a. Create PDF Compatible File allows you to open the file in Adobe. 

b. Embed ICC Profiles are your color profiles; therefore, you may want to leave this option 

checked. 

c. Use Compression will make the file smaller on a disk. 
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8. Once you have made your selections, select OK. 

 

 
Figure 40: Illustrator Options 

 

Printing 
 

1. Choose File from the menu bar and select Print. 

2. In the Print dialog box that appears, select a printer if the correct one is not already selected 

(See Figure 41 on the next page). 

 

3. If the PPD is not selected, choose one from the PPD drop-down list. 

*Note: A PPD is a printer description file.  Illustrator needs one in order to determine the 

specifics of the PostScript printer you are sending your file to. This setting lets Illustrator know 

whether the printer can print in color, the paper size it can handle, and its resolution, as well as 

many other important details. 

 

4. Choose from the other options available.  
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*Note: For example, use the General section to pick pages to print.  In the Media area, select 

the size of the media you are printing to.  In the Options area, choose whether you want layers 

to print and any options specific to printing layers. 

 

5. Once you have selected all of your options, click the Print button. 

 

 

 
Figure 41: Printing Dialog Box 
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Resources  
Adobe publishes many video tutorials on their site.  

Visit http://helpx.adobe.com/illustrator/illustrator-cs5-cs55-tutorials.html to access Illustrator tutorial 

content from Adobe. 

Adobe also publishes video tutorials to YouTube on the Adobe Illustrator channel, available at 

http://www.youtube.com/user/AdobeIllustrator. 

Tools panel overview, credit: Adobe, see 
http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0100196cbc5f-6337a.html 

Additional Support 
For additional help or installation issues, please contact the KSU Service Desk (Faculty & Staff) or the 

KSU Student Help Desk (Students). 

KSU Service Desk for Faculty & Staff 

• Phone: 470-578-6999 

• Email:

• Website:

service@kennesaw.edu 

http://uits.kennesaw.edu/faculty-

staff/ 
KSU Student Help Desk 

• Phone: 470-578-3555 

• Email:

• Website:

studenthelpdesk@kennesaw.edu 

http://uits.kennesaw.edu/

students/ 

http://helpx.adobe.com/illustrator/illustrator-cs5-cs55-tutorials.html
http://www.youtube.com/user/AdobeIllustrator
http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0100196cbc5f-6337a.html
mailto:service@kennesaw.edu
http://its.kennesaw.edu/faculty-staff/
mailto:studenthelpdesk@kennesaw.edu
http://its.kennesaw.edu/students/

